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1. INTRODUCTION 

WIINdow Glazing Analysis Response and Design (WINGARD) was developed for the General 

Services Administration by Applied Research Associates (ARA).  The goal was to develop a simple 

but accurate mode of the response of windows to the effects of an explosion.  The program, 

which has become the national standard for analysis of glazing for blast loadings, calculates and 

graphically displays the response of window systems subjected to blast loads.  WINGARD is an 

analysis tool that accepts user input of window system properties and explosion characteristics, 

and then calculates the performance of the window system when subjected to defined blast 

loads.  The WINGARD software is available in two versions: WINGARD LE (Limited Edition) and 

WINGARD PE (Professional Edition). 

WINGARD LE is distributed as a less sensitive, more public version of the program and is capable 

of determining the response of a range of glazing types subjected to a pressure and impulse 

loading combination.  WINGARD LE will analyze both single and double pane windows; however, 

complex stacked plate lay-up assemblies cannot be created. 

WINGARD PE is a much more powerful version of the software and is limited to government 

employees and contractors working on related government projects.  The program contains 

many useful features for engineers and security specialists.  It is a convenient tool to explore 

alternative window layups to determine if they meet required performance levels such as those 

specified in the GSA and ISC Security Criteria.  WINGARD PE can provide an estimated response 

for a single loading, evaluate capacity for a target performance condition index, or develop 

Pressure-Impulse curves for the system.  Results are displayed in a variety of formats: a short text 

summary, graphs of key parameters (including load, resistance, displacement, and fragment 

flight, support reactions) and a brief report with results and graphs.  

The most recent version of WINGARD PE, Version 6.2 incorporates advanced models for analysis 

of thick laminate into the interface previously developed for Version 5.0 and adds SentryGlas® 

Xtra SG 6000 to the standard laminate library.  SentryGlas® SG 5000 supersedes the SGP (Elastic) 

and SGP (Elastic-Plastic) laminates, which remain in the software for backwards compatibility.  

Improvements have also been made to the Report Writer to make use of the latest Microsoft 

Word formats.  The updated Report Writer eliminates the need to have an installed copy of 

Microsoft Word or Office to accommodate the varied options of Office 365 functionality. 
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2. PROGRAM OVERVIEW 

The main program screen of WINGARD PE is divided into several functional elements.  The major 

program elements include the Program Menu, the Main Toolbar, the Analysis Control Area, the 

Output Control Area, and the Display Area as illustrated in Figure 2.1. 

 

Figure 2.1.  Opening screen for WINGARD PE 6.1. 
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2.1. PROGRAM MENUS 

Three Program Menus are available: the File Menu, the View Menu, and the Help Menu. 

The File Menu has standard windows file operations (New, Open, Save, Save As, Print, Exit), as 
well as operations unique to WINGARD (Save DPLOT files, Import WINGARD 4.1 files, Run 
Analyses, Run P-I Curves, and Write Report).   

Some File Menu options require the user to highlight one or more 
Window Systems in the Analysis Control Area before the options are 
enabled (Save DPLOT files, Print, Run Analysis, Run P-I Curves, Write 
Report).  Disabled menu options are gray font, while available 
options are black font.  When enabled, these options will only be 

applied to the Window Systems highlighted in the Analysis Control 
Area. 

 

 

 

 

 

The View Menu is associated with the Display Area of the Main Screen.  The user may choose to 
display one of the input libraries or to display available output.  When output is being displayed, 

the user may also control the size of the output 
items.  The output may be sized to fit between 
1 and 20 items on the screen at a time. 

The output display feature will be disabled until 
output items are selected in the Output Control 
Area. 

 

The Help Menu provides access to this User Guide, the 
Technical Manual, the Window System Assessment 
Guidelines, the Tutorials, the Release Notes, License 
Information, and the About Screen. 
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2.2. MAIN TOOLBAR 

 

The Main Toolbar provides an alternative method to accomplish most items in the Program 

Menus.  The program utilizes a variety of icons to simplify common tasks and allow quick access 

to the various libraries. 

New File 

  Click this icon to start a “new” project.  A project contains one or more DCMS models. 

Open File  

 Click this icon to open previously saved files.   

Save File 

 Click this icon to save your file. 

Charge Library 

 Click this icon to access the Charge Library. This library is used to store and define standard 
explosive charge types and corresponding TNT equivalency.  

Film Library 

Click this icon to access the Film Library.  This library is used to view and define window 
films for use in defining custom window layups. 

Laminate Library 

Click this icon to access the Laminate Library.  This library is used to view and define window 
laminates for use in defining custom window layups. 

Glass Library 

Click this icon to access the Glass Library.  This library is used to view and define both brittle 
and ductile glass materials for use in defining custom window layups. 

Airblast Load Library 

Click this icon to access the Airblast Load Library.  This library is used to define loads linear 
equivalent and time-history blast loads that may be used for analysis of WINGARD models. 

Layup Library 

Click this icon to access the Layup Library.  This library is used to view and define window 
layups from combinations of film, laminates, and glass for use in WINGARD models. 
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Output 

Click this icon to open the Output View.  This icon is only available if there is valid output 
that can be displayed. 

Output Items per page 
Use this icon to define the number of output items to display on the screen.  Click the down 
arrow on the right of the icon to view and select the number of items to display.  This icon 

is only active when output is being displayed in the Display Area. 

About 

Click this icon to learn more about the current version of WINGARD. 

 

2.3. ANALYSIS CONTROL AREA AND TOOLBAR 

  

The main section in the Analysis Control Area consists of a listing of all Window Systems in the 

WINGARD project file.  This list is always visible and allows analysis to be performed or output 

from any other view within the program.  Each time a new Window System is created, the system 

name is added to a list in the Analysis Control Area.  Many of WINGARD's features are applied 

only to Window Systems selected in the analysis list.  To select Window Systems from the list, 

use the mouse and click on the appropriate window system.  The Ctrl and Shift keys can be used 

to select multiple Window Systems. 

The Analysis Control Area also has its own toolbar containing context sensitive operations.  The 

operations performed by this toolbar will be performed on all highlighted Window Systems. 

Run Analysis 

 Select one or more Window Systems and click this icon or press F5 to run analysis of the 
selected Window System(s).   

Pressure-Impulse Analysis 

Select one or more Window Systems and click this icon to run a P-I Curve analysis of the 
selected Window System(s). 
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A dialog box, as illustrated adjacent, will appear.  Select the Target 
Damage States (Condition Indexes) for each PI Curve desired.  If 
multiple targets are selected, calculations may take several minutes.  
Double clicking on 'Include?' will select/unselect all conditions. 

Each P-I curve will plot one point for each duration shown (in 

milliseconds).  Duration values may be revised or added prior to clicking 

“OK”. 

Select Pressure vs Impulse or Impulse vs Pressure to define output 

graph orientation.  Click “OK” to start the PI Curve analysis or “Cancel” 

to close the dialog without conducting the PI Curve analysis. 

 
 
 
 
 
 

 
D Plot 

Select one or more Window Systems and click this icon to Save output graphs as DPLOT 
files for the selected (highlighted) Window System(s). 

A dialog box, illustrated adjacent, will appear.  Click +  or 
– in the tree to expand/collapse the heading and view 
individual output items.  Right clicking on the tree 
provides a pop-up menu that allows the user to change 
the viewing option between “group by window system” 
and “group by output type”.  The user also has the option 
of using default file names and saving in the same folder 
as the main WINGARD file or manually defining the 
filename and location 
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Print 
Select one or more Window Systems and click this icon to Print output for the selected 
Window System(s). 

 
A dialog box, illustrated adjacent, will appear.  Select the 
output items to print for each available window system.  
Click + or – in the tree to expand/collapse the heading and 
view individual output items.  Right clicking on the tree 
provides a pop-up menu that allows the user to change 
the viewing option between “group by window system” 
and “group by output type”. 
 
 
 
 

 
Write Report 

Select one or more Window Systems and click this icon to Write a Report for the selected 
Window System(s). 

 

A dialog box with three tabs will appear.  After completing the fields under each tab, click the 

Write Report button. 

 

General Information Tab -- Select a logo 

file, provide a Report Title for the cover 

page, select a footer from the drop-down 

menu and optionally insert a Summary File 

that will be included in the report. 
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Author Information Tab -- Provide details 
on the author which will appear on the 
cover page of the report.  This information 
will be used in all reports generated until 
changed.  

Although the program attempts to save 
and load the specified company logo and 
Author Information when the program 
closes, clicking the Save Info button will 
allow this information to be saved in a 
user-specified location.  Clicking the Load 
Info button will allow the user to import 
saved information.  The information is 
saved in an xml formatted WINGARD 
Library (*.wgl) format. 

 
Content Tab -- Select the window systems 
and graphs to include in the report, using 
the same procedures described for 
displaying Output. 
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2.4. OUTPUT CONTROL AREA 

 Each time a new Window System is created, the 

system name is added to a tree in the Output 

Control Area.  Click + or – in the tree to 

expand/collapse the heading and view individual 

output items.  Right clicking on the tree provides a 

pop-up menu that allows the user to change the 

viewing option between “group by window system” 

and “group by output type”.  Right clicking on a 

particular Window System will also allow the user to 

switch between English and Metric output units for 

that system. 

The entries in the output tree are initially disabled (grayed-out).  However, once analysis for a 

Window System is complete, the associated text will change to black to signify that the output is 

available.  Click the applicable check boxes in the expanded tree to select/deselect specific output 

items or check the main tree headings to select/deselect all associated output options. 

2.4.1. OUTPUT GRAPH INTERACTION 

All graphs provide standard interactivity features for zooming, panning, copying, printing, 

changing axis and other graph properties.   

Zoom -- Left click and drag a selection box around a section of the graph to zoom in. 

Copy -- Right click on a graph, select Copy and the graph will be copied to the Clipboard. 

Print -- Right click on a graph and select Print. 

Axis Controls -- Right click on a graph and select X-Axis or Y-Axis.  The user may convert the axis 

to a logarithmic scale or reset the axis scale to default after zooming or scaling. 

Scale Properties -- Right click on a graph and select Scale Properties.  Enter plot ranges for the X 

and Y-Axes and the number of display intervals.  Autoscale scales as appropriate to provide an 

overall view of the data.  A logarithmic view may be selected to convert the axis to a logarithmic 

scale.  It is not possible to plot zero on a logarithmic scale.  Therefore, data containing zeros or 

negative data will not plot on a log scale. 

Save as DPlot File – Right click on a graph and it may be saved in DPlot format. 

Save as CSV File – Right click on a graph and it may be saved in Comma Separated Values (CSV), 

text-based format.  The first row will list the labels for the data in each comma-separated column 

and associated units.  Subsequent rows will have the data for the curves saved from the plot. 
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2.5. DISPLAY AREA 

The Display area displays the currently selected input library or output items.  For example, the 

input for a glazing layup input is illustrated below. 

 

The display area containing output from a typical analysis is illustrated in the following figure. 
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3. INPUT LIBRARIES 

 

Six data libraries may be accessed via the Main Toolbar or the View menu.  These libraries include 

Charge Types, Film Types, Laminate Types, Glass Types, Airblast, Lay-up, and Window System.  All 

libraries share common features and operations.  These common features include a table of 

library entries and a Library Toolbar.  Default library entries are provided and cannot be altered 

or deleted.  The default entries appear in grey font in the table.  User defined entries will appear 

in black font and can be edited or deleted. 

3.1. BASIC TABLE OPERATIONS 

A basic feature of WINGARD PE  is the input table.  Input tables consist of a series of cells arranged 

to form rows and columns.  Cell values may be replaced by single clicking on the appropriate cell 

and typing a new entry.  Double click to edit the existing information in the cell. 

Individual library entries appear as rows in the libraries main input table.  Many of the library 

functions, such as copy, save, and delete, require the user to first highlight one or more library 

entries.  Selecting any cell will highlight the entire entry.  To highlight multiple entries the shift 

and ctrl keys may be used.  To select a block or range of fields, single click the first entry in the 

block, then hold the shift key while selecting the final entry in the block.  All entries between 

those selected will be highlighted.  Blocks of entries may also be selected by dragging the mouse 

over a series of entries while holding the left mouse button.  The user may also add or remove 

entries to the highlighted group by holding the ctrl key and selecting the appropriate entries. 

 

There are four basic types of cells in WINGARD: 
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3.1.1. TEXT INPUT 

As the name suggests, text input cells allow the user to input a text string.  The string may include 

letter, numbers, and symbols (including spaces). 

3.1.2. NUMBER INPUT 

Number input cells allow the user to input numerical values.  All numbers should be input in a 

decimal format with a period '.' as the placeholder.  Exponentials may be defined by appending 

the 'E' or 'e' characters to the end of a number followed by the power of the exponential, e.g., 

1200000 may be entered as 1.2E06. 

Number input cells generally have units associated with them.  The user should enter the decimal 

number only.  Units will be automatically assigned based on the selected Display Units for the 

corresponding library entry. 

Number input cells generally have constraints placed on their input values.  Entry of a value 

outside the cells constraints will result in a pop-up error message with a description of the 

constraints. 

3.1.3. SELECTION BOX 

Selection Boxes consist of a check box allowing the user to turn a feature on or off by clicking on 

the box. 

3.1.4. DROP-DOWN LISTS 

Some table entries have a down arrow in the right corner of the cell.  Clicking the arrow will 

display a list of possible entries for the associated cell.  In some cells, this is the only means of 

defining the entry.  In other cases user defined entries are also allowed.  
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3.2. LIBRARY TOOLBAR 

 

Individual library entries appear as rows in the main input table.  The library toolbar is used to 

perform operations on these entries.  Many of the library functions, such as copy, save, and 

delete, require the user to first highlight one or more library entries.  Selecting any cell will 

highlight the entire row.  To highlight multiple entries, use the Shift and Ctrl keys. To select a 

block or range of fields, single-click the first entry in the block, then hold the Shift key while 

selecting the final entry in the block.  All entries between those selected will be highlighted.  

Blocks of entries may also be selected by dragging the mouse over a series of entries while 

holding the left mouse button.  The user may add or remove entries to the highlighted group by 

holding the Ctrl key and selecting the appropriate entries. 

The Toolbar functions above are:  Add, Import, Save, Append, Copy or Delete. 

Add 

 Begin a new library entry.  Library entries are created with default parameters.  Select the 
appropriate cells to alter the default values. 

Copy a Library Entry 

Highlight one or more library entries then click the copy icon.  The new entries will be 
appended at the end of the list. 

Import 

Load previously saved library entries. 

Save 

Click this icon to save selected entries to a new library file. 

 

Append 

Click this icon to append selected entries to an existing library file. 
 

Delete a Library Entry 

Highlight a library entry and click the delete icon.  Default entries may not be deleted. 
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3.3. CHARGE TYPE LIBRARY   

The Charge Type Library consists of two items: the table of library entries and the Library 

Toolbar.  A set of default charge types and parameters appears in grey font in the table; 

the default charge types may not be altered or deleted.  Click on the Add entry icon  on the 

Library Toolbar to add new charge types.  As new charge types are added, they are saved to the 

global template and will be available when the program is opened again. 

3.4. FILM TYPES LIBRARY  

The Laminate Type Library consists of two items: the table of library entries and the Library 

Toolbar.  A set of default laminate types and parameters appears in grey font in the table; 

default laminate types may not be modified or deleted.  Display Units is the only field which may 

be modified; click the field under the Display Units heading to change the units.  Click on the Add 

entry icon  on the Library Toolbar to add new laminate types.  As new laminate types are added, 

they are saved to the global template and will be available when the program is opened again. 

3.5. LAMINATE TYPES LIBRARY  

The Laminate Type Library consists of two items: the table of library entries and the Library 

Toolbar.  A set of default laminate types and parameters appears in grey font in the table; 

default laminate types may not be modified or deleted.  Display Units is the only field which may 

be modified; click the field under the Display Units heading to change the units.  Click on the Add 

entry icon  on the Library Toolbar to add new laminate types.  As new laminate types are 

added, they are saved to the global template and will be available when the program is opened 

again. 

3.6.  GLASS TYPES LIBRARY 

Data for Glass Types are separated into tables for Brittle and Ductile materials.  Each table 

contains input parameters relevant to the selected type of glass.  Default glass types and 

parameters appear in grey font.  The default glass types may not be altered or deleted.  Two 

fields which may be modified in the default entries are the Display Units and Display Color.  Click 

the field under each heading to change the unit or color.  The display color is used to represent 

the glass type in the glazing lay-up display.  Click on the Add entry icon  on the Library Toolbar 

to add new glass types.  As new glass types are added, they are saved to the global template and 

will be available when the program is opened again. 
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3.7. AIRBLAST LIBRARY  

The airblast library contains two default entries: 

4   psi / 28 psi-msec (ISC Medium) 

10 psi / 89 psi-msec (ISC High) 

Default airblast types may not be altered or deleted. 

Two types of user defined entries may be added: 

 Linear Equivalent 

 Time-Pressure History 

Click on the down arrow next to the add entry icon  on the Library Toolbar to choose between 

these two entry options.  New airblast types will not be saved to the global template, but will be 

saved with the problem data when the program is closed.  Additional information becomes 

available in the lower section of the Display Area once the selection box in the 'Display' field is 

checked and includes a table of pressure-time pairs and a graph of the loading function. 

3.7.1. LINEAR EQUIVALENT ENTRY 

A linear equivalent entry will require the 'Peak Pressure' and 'Load Duration' Fields to be 

completed in the table of library entries.  The pressure-time history table cannot be otherwise 

edited for a linear equivalent airblast library entry. 

3.7.2. TIME PRESSURE HISTORY 

The time-pressure history toolbar allows the user to define a series of time-pressure pairs in the 

in the table near the center of the screen.  The time-pressure table has it own toolbar as shown 

below: 

 

Click the icons to Import, Add, Insert, Delete points in the table or to Copy and Paste from the 

clipboard.  Time-Pressure histories may be imported from text files that are comma-delimited or 

tab-delimited.  Clipboard entries can be copied and pasted from programs such as Excel and 

DPLOT that store information in a tabular format.  The current pressure-time history is plotted as 

the data points are being created and/or edited.  Right-clicking on the graph allows the user to 

perform the same operations available with any output graph. 
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3.8. LAY-UP LIBRARY  

The term “glazing layup” refers to the through-thickness composition of the glazing.  Figure 

3.1 shows the cross-section of a generic glazing layup with the various components labeled. 

 

Figure 3.1.  Complex glazing system. 

 

The glazing lay-up is composed of panes, plates, and layers.  The most basic component of the 

lay-up is the layer.  Material properties and thickness are defined for individual layers.  An 

assembly of one or more layers that act together in a composite fashion is called a plate, and one 

or more adjacent plates can combine to form a pane.  Panes are separated by airgaps and move 

separately.  Plates and layers, on the other hand, are assumed to move as a unit.  Plates are 

treated in the analysis as “stacked”, with no horizontal shear transfer between then.  Multiple 

layers in a plate, however, are assumed to act in a composite fashion.  The program is currently 

limited to analysis of two panes.  The inner pane may have applied film, but the outer pane may 

not.  Either or both panes may consist of one or more plates and each plate may consist of one 

or more layers. 
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A table of lay-up library entries appears in the upper portion of the display area and detailed 

parameters on each lay-up type may be displayed below in the lower table by checking the 

selection box in the rightmost column of the upper table.  Several typical layups are included as 

defaults in the program.  These default layups include single pane and double pane layups, with 

monolithic and/or laminated panes.  These default layups may not be modified but may be 

copied and edited to create similar layups. 

3.8.1. ADDING, MOVING, OR REMOVING LAYERS OR PLATES 

Layers and plates may be added or removed using the right click menu or the Lay-up Toolbar.  

Right clicking on a layer or plate in the lay-up table will bring up a menu of editing options.  These 

options include: 

       Layer Level         Plate Level 

Add glass layer Add multi-layered plate 

Delete glass layer Delete multi-layered plate 

Clone glass layer Clone multi-layered plate 

Insert glass layer Insert airgap plate 

Add laminate layer Insert multi-layered plate 

Delete laminate layer Insert film plate 

Clone laminate layer  

Insert laminate layer  

 

New layers and plates may also be added using the Lay-up Toolbar.   

 
 

 Add new multi-layered plate 

 Add new film plate 
 

 Add new airgap plate 
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 Add new glass layer 
 

 Add new laminate layer 
 

Plates and layers may be moved in the lay-up by selecting the desired component and dragging 

it to the appropriate position in the lay-up. 

 

3.9. DEFINE A NEW WINDOW SYSTEM 

Configure a new window system in the upper table by selecting the Add entry icon  on 

the Library Toolbar or selecting an existing window system for editing.  When a new 

window system is created, the window system ID appears in the Analysis Control Area list.  Enter 

basic window system data to include a name for the system, a description, dimensions, and 

height above floor.  To specify bite, click the Specify Bite check box and enter a bite value.  If the 

Specify bite check box is not checked WINGARD will calculate the minimum bite required to fully 

develop the window response.  Click the Display box to view specific window analysis selections 

in the lower Display Area. 

Specific window system conditions including Output Method, Layup ID, Airblast Method and Edge 

Conditions are defined in the lower table.  Click the appropriate field in the Value column to enter 

or adjust the required parameters. 

3.9.1. OUTPUT METHOD 

WINGARD can provide output based on either GSA Performance Conditions or ASTM Hazard 

Conditions.  If GSA is selected, the glass response will be designated as Performance Condition 1 

(Uncracked, glass remains in frame) to Performance Condition 5 (Hazardous Failure).  If ASTM is 

selected, the output will report glass hazards consistent with ASTM F1642, ranging from No Break 

to High Hazard. 

3.9.2. LIBRARY LAYUP ID 

A lay-up is selected from the Layup Library using a dropdown menu.  If the desired lay-up is not 

available from the drop-down menu, go to the Lay-up Library by selecting the layup icon  from 

the Main Toolbar.  Return to the Window System Library after creating the desired layup and 

select the new layup from the dropdown menu. 
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3.9.3. AIRBLAST METHOD 

Select an entry from the airblast library or choose one of the two manual entry options.  The 

airblast library is typically used for loadings that may be used/re-used in a number of window 

system analyses.  Manual entry is typically used for more specific problems where a charge 

weight is specifically defined.  If Manual entry is selected, the user may optionally show a graphic 

illustrating the required input. 

Manual Entry -- There are two options for manual entry: 

Standoff and charge weight.  Charge weight, standoff distance, angle of incidence, and 
device and loading parameters are specified. 

Location (X, Y, Z) and charge weight.  For a Cartesian coordinate system, the x-, y- and z- 
offsets from the bomb to a vertical plane surface are entered and the program calculates 
the angle of incidence.  Additional device and loading parameters are required. 

Maximum Performance Condition -- It is possible to select a target hazard condition and let 

WINGARD vary the loading parameters to determine the maximum load that will result in the 

target hazard condition.  Pressure will be varied for the defined duration if a linear equivalent 

airblast library entry is defined.  Charge weight will be varied for the specified standoff or location 

if manual entry is selected.  In either case, the user defined values will be used as an initial guess 

in the iterative solution. 

3.9.4. EDGE CONDITIONS 

Set edge conditions for film attachment (if applicable), butt glazing, and/or wet glazing as 

appropriate.  Wet-glazed and/or butt-glazed conditions are defined by clicking the respective 

checkbox. 

For Attached Film select the attachment method and attached edges as appropriate (i.e., 

daylight, two-sided vertical, two-sided horizontal, four-sided). 

For Butt Glazing choose the supported edge (i.e., vertical or horizontal edge).  Note that the 

supported edges are not the butt-glazed edges. 

For Wet Glazing choose the attached edge (i.e., vertical or horizontal edge) and the silicone 

properties (i.e., depth and strength). 
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4. ANALYSIS STEPS 

Some or all of the following steps may be required to prepare and analyze a window system in 

WINGARD PE: 

 

All of the data on the Window System screen must be completed prior to analysis of the window 

system.  To set additional lay-ups and airblast loading not available on the Window Systems 

screen, go to the relevant library and add new entries.  In many cases, the default data is sufficient 

for an analysis. 

The relationship between the various data libraries is presented in the following Figure 4.1.  This 

chart indicates the dependencies between data libraries, e.g., the window system is dependent 

on the defined layup library, which is in turn dependent on the glass, film, and laminate libraries. 
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Figure 4.1.  Input data dependencies. 
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5. SAMPLE PROBLEMS 

Task 

Analyze a window system for a 4 psi and 28 psi-msec blast load.  The rough 
opening dimensions are 60 inches by 75 inches, and the windowsill is located 
28 inches above the floor.  The glazing consists of a 1-inch insulating glass 
unit (IGU) with a 1/4 inch laminated thermally tempered inner pane, 1/2 inch 
air gap and a 1/4 inch monolithic heat strengthened outer pane.  Determine 
the gasket centerline dimensions as appropriate.  The frame bite should be 
1/2 inch. 

 

The following figure is a sketch showing the window system.  The figure illustrates the vision 

opening, rough opening, and centerline gasket dimensions.  The centerline gasket dimensions 

should be used in the WINGARD PE analysis. 

 

 

 

 

 

 

 

 

 

 

 

 

 

The analysis will use standard glazing and laminate types.  Therefore, the film library, laminate 

library, and glass library will not be modified.  In addition, the ISC Medium design load is a default 

entry in the airblast library, so the airblast library will not be modified. 
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5.1. STEP 1: BUILD THE APPROPRIATE GLAZING LAYUP IN THE LAYUP LIBRARY 

The first step in the analysis process is to build the appropriate glazing layup. 

Begin by selecting the Layup Library   on the Main Toolbar. 

Go to the Library Toolbar  and select add layup  . 

On the Layup Toolbar  add new multi-layered plate  

Then, add a new glass layer , a new laminate layer , and a new glass layer . 

The inner pane is complete, and the WINGARD PE input screen should now look like this: 

 

Continue to add to the glazing layup by adding a new airgap plate  and a new multi-layered 

plate , and a new glass layer . 
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At this point, all plates and layers have been created.  The input screen should look like the 

following: 

 

 

 

5.2. STEP 2 MODIFY THE GLAZING TYPES AND THICKNESS OF THE LAYUP 

Begin by setting the glass types on the 

inner pane layers to Thermally 

Tempered. 
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Set the glass type on the outer pane to Heat 

Strengthened.  

 

 

 

 

 

 

 

 

Next, set the glass thickness on the outer pane to ¼ inch using the drop-down menu and selecting 

a nominal thickness of ¼ inch.  (Note that the actual thickness of 0.219 inch is used for the layer). 
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Finally, rename the 

layup by clicking on the 

ID.  Set the name to "1-

in IGU". 

 

 

 

 

 

 

5.3. STEP 3 CREATE THE AIRBLAST LOAD 

Begin by selecting the airblast input screen  on the Main Toolbar. 

Go to the Library Toolbar    and select Add entry  and choose Linear 

Equivalent from the pull-down menu. 

Name the Linear Equivalent load “4 psi/ 28 psi-msec”. 

Choose the Display Units (English) and enter the peak pressure (4 psi) and load duration (14 

msec). 

 

5.4. STEP 4 DEFINE THE WINDOW SYSTEM 

Begin by selecting the window system input screen  on the Main Toolbar.           

Go to the Window System Library Toolbar    and select Add entry  . 

Name the window system “60-in by 75-in IGU.   

Enter the centerline gasket dimensions for the window opening (68.526 inches x 53.526 inches) 

and the height above floor (28 inches). 

Enter a bite of 0.5 inches. 
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Next, select the layup library ID for the layup you created. 

Then, select the newly created 4 psi/28 psi-msec airblast load from the airblast library. 

 

5.5. STEP 5 RUN ANALYSIS AND VIEW RESULTS 

The window system is now complete. The next step is to run the analysis and view the results. 

Run the analysis by selecting the “60-in by 75-in IGU” window system in the upper left Analysis 

Control Area and clicking the run analysis icon  on the toolbar. 

Results can be viewed by selecting the desired output plots in 

the lower left window. 

Selecting the plus sign by the system name will expand the 

output tree and allow the user to select between the individual 

types of output available. Control of individual output is 

controlled by the associated check boxes. 
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The color of the icon beside the model 

name now represents the performance 

condition of the window. These colors 

are based on the Fragment Flight Graph. 

As you can see in this model the window 

has a performance condition of 2. 

 

 

 

 

This can be verified in the “RESULTS” of the Analysis Text. 
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Clicking the checkbox by the system name selects all potential outputs and displays them in the 

output view area. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The number of output views on screen may be changed as required using the output view 

dropdown. 

 

Results may also now be printed or saved to DPlot or CSV files or a report may be generated. 


